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enter the world of it – key book - 1 to 8

Class : 1   KEY ANSWERS

Chapter 1.  The world of machines
Page No. 15-16

I.	 Fill in the missing letters:
1.	 Machine
2.	 Computer
3.	 Games
4.	 Books
5.	 Fast

II.	 Choose the correct word from the box:
1.	 Electricity
2.	 Fast
3.	 Machine
4.	 Information
5.	 Mistake

III.	 Match the following:

1.	 Railway station	 -	 reserve tickets
2.	 Hospitals	 -	 Maintain patient records
3.	 Banks	 -	 maintain savings
4.	 Super Market	 -	 generate bills
5.	 School	 -	 learn subjects

IV.	 Answer the following:

1.	 �Machine makes our work easy. We use 
­machines to finish our work faster and ­easier.

2.	 Fridge, Washing machine, Fan, TV, AC.
3.	 �Calculator, Camera, Mobile phone, Pencil, 

Sharpener, Scissors.
4.	 A computer is an electronic machine.
5.	 �School, Bank, Supermarkets, Hospitals, 

Railway station.

V.	 Draw a mind map on the uses of computers 
in your note book.

Uses of 
Computers

Used to play 
games

Used to 
store lot of 

information

Used to draw 
pictures

Perform 
calculations 
very easily

Chapter 2.  PARTS OF THe COMPUTER
Page No. 25-26

I.	 Fill in the blanks using the clue box:
1.	 Charles Babbage.
2.	 CPU
3.	 Monitor
4.	 Speaker
5.	 Keys

II.	 Solve the puzzle with the help of the pictures:

m

o

u

e

o n t o r

k

e a k e

y

b

o

a

r

d

s p r

i
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III.	 Answer the following questions:

1.	 Charles Babbage invented the computer.
2.	 The main parts of the computer are:

1. Keyboard
2. CPU
3. Monitor
4. Speaker
5. Mouse

3.	 Monitor looks like a television.
4.	 CPU is the brain of the computer.
5.	 CPU - Centre Processing Unit.

IV.	 Draw a mind map on the parts of a 
computer in a note book.

Parts of a Computer

Keyboard CPU Monitor Speaker Mouse

Activity Zone:

I.	 Identify the parts of a computer
1.	 Monitor
2.	 CPU
3.	 Speaker
4.	 Mouse
5.	 Keyboard

II.	 Who am I?
1.	 Monitor
2.	 Mouse
3.	 Speaker
4.	 Keyboard
5.	 CPU

Chapter 3.  Mouse – My friend
Page No. 35-37

I.	 Fill in the missing letters:
1.	 Mouse
2.	 Click
3.	 Pointer
4.	 Select
5.	 Drag

II.	 Choose the right word from the help box:
1.	 Input
2.	 Flat
3.	 Two or Three
4.	 Doug Engelbart
5.	 Double Click

III.	 Answer the following:
1.	 �The mouse is an input devices used for a 

variety of purposes.
2.	 �It used to draw pictures, move and select 

things on the monitor, play games.
3.	 �It is a pointing and drawing device shaped 

like a pen.
4.	 �Click Action is used to select any option on 

the screen.
5.	 There are two types of mouse.

1. Mechanical mouse
2. Optical mouse

IV.	 Draw a mind map on the different mouse 
actions in a note book.

Different Mouse Actions

Click

Used to 
select any 
option on 

screen

Open a 
document

Displays 
a list of 

options on 
monitor

Used to 
mouse an 

object

Double 
Click

Right 
Click

Drag and 
Drop

Chapter 4.  Keyboard and its keys
Page No. 43-45

I.	 Choose the correct answer from the box:
1.	 Keyboard
2.	 Numbers
3.	 Four
4.	 Spacebar
5.	 Two

II.	 Choose T for True and F for False:
1.	 False
2.	 True

3.	 True
4.	 False

5.	 True
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III.	 Answer the following questions:
1.	 �The keyboard is used for typing character 

number and other symbols on the monitor.

2.	 F1 F2 F3 F4 F5 F6

F7 F8 F9 F10 F11 F12

3.	 ← → ↑ ↓
home end

pg up pg down

4.	 �Arrow keys are used to move the cursor in 
the right, left, up, down directions.

5.	 �Backspace key is used to erase a character, 
number or words.

IV.	 Draw a mind map on the different kinds of 
keyboard keys in a notebook.

Kind of keyboard keys

Alphabet 
key

Number 
key 

Function 
keys

Special 
keys

Arrow 
keys

Activity Zone:

I.	 Colour the keys according to the colour 
code
1.	 Enter key
2.	 Arrow keys
3.	 Number keys
4.	 Spacebar key
5.	 Shift keys

Chapter 5.  Notepad
Page No. 51-52

I.	 Fill in the missing letters:
1.	 Notepad
2.	 Keyboard
3.	 Cursor
4.	 Desktop
5.	 Window

II.	 Fill in the blanks using the help box:
1.	 Notepad
2.	 Keyboard

3.	 Cursor
4.	 Windows Accessories
5.	 Typing

III.	 Match the following:
1.	 Notepad	 -	 Typing program
2.	 Cursor		 -	 Blinking line
3.	 Keyboard	 -	 Input device
4.	 Monitor	 -	 Output device
5.	 White area	 -	 Typing area

IV.	 Answer the following:
1.	 �Writing something on the computer is 

called typing.
2.	 1. Click the start button on the desktop.

2. Click on windows accessories option.
3. Click on Notepad.

3.	 �Blinking line moves as you type every letter. 
This Blinking line is the cursor point.

4.	 In the start button option.
5.	 Keyboard.

V.	 Draw a mind map of the things that you 
have learnt about Notepad in a notebook.

Notepad

White area Typing area Cursor point Window 
accessories

Chapter 6.  LET’S START PAINTING
Page No. 62-64

I.	 Fill in the missing letters:
1.	 Pencil
2.	 Circle
3.	 Rectangle
4.	 Eraser
5.	 Line

II.	 Fill in the blanks using the help box:
1.	 Rectangle
2.	 Line
3.	 Circle or Oval

4.	 Erase
5.	 Fille with color

4
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III.	 Match the following:
1.	 Pencil	 -	
2.	 Fill with colour	 -	
3.	 Line tool	 -	
4.	 Rectangle tool	 -	
5.	 Circle tool	 -	

IV.	 Answer the following:
1.	 To open paint.

Start → Windows → Accessories → Paint
2.	 �Paint is a program that is used to draw and 

paint pictures on the computer.
3.	 �Line tool, Eraser tool, Pencil tools, Rectangle 

tool, circle tool.
4.	 Pencil tool.
5.	 Drawing area, Tool box, Colour box.

Chapter 7. � INPUT, PROCESS AND 
OUTPUT UNITS

Page No. 70-71

I.	 Choose the correct answer from the box:
1.	 Keyboard
2.	 Monitor
3.	 3
4.	 CPU
5.	 Output

II.	 Answer the following questions:
1.	 �Output unit is used to show the result. Input 

unit is used to give commands to the computer.
2.	 Memory unit, Control unit, ALU
3.	 Mouse, Keyboard
4.	 Monitor, Speaker
5.	 �The Instruction flows from the input device 

to the processing device and then to the 
output device. This is called LPO cycle.

III.	 Draw a mind map on CPU units in a notebook.

CPU

Memory unit Control unit ALU

Chapter 8. � Introduction to 
categories

Page No. 75-77

I.	 Fill in the missing letters:
1.	 Categories
2.	 Grouping
3.	 Data
4.	 Program

II.	 Choose the correct words from the box.
1.	 Data
2.	 Two
3.	 Apperances
4.	 Vehicles
5.	 Catagories

III.	 Match the following:
1.	 Vehicles	 -	 Non-living thing
2.	 Humans	 -	 Living thing
3.	 Bus		  -	 Vehicles
4.	 Man		  -	 Human

IV.	 Answer the following:
1.	 �Grouping is done based on physical 

appearances.
2.	 �Categories formed on their appearance and 

characteristics.
3.	 �Grouping is done based on physical 

appearances.
4.	 �There are programs in computer used to 

group data based on our need.
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Class : 2   KEY ANSWERS

Chapter 1.  The world of machines
Page No. 13-16

I.	 Choose the correct answer:
1.	 5
2.	 CPU
3.	 ALU
4.	 Memory
5.	 3

II.	 Expand the following:
1.	 CPU - Central Processing Unit
2.	 CU - Control Unit
3.	 MU - Memory Unit
4.	 ALU - Arithmetic Logic Unit
5.	 PC - Personal Computer

III.	 Answer the following:
1.	 �The CPU is made up of a Mother - Board, 

Processers - (Intel, AMD), RAM and Hard 
Disk.

2.	 �ALU Performs all Arithmetic operations and 
logical operations.

3.	 �A set of instructions used to perform a specific 
task or particular task is called software.

4.	 �A physical parts of a computer are called 
Hardware.

5.	 �Memory Units are the storage areas in a 
computer.

IV.	 Draw a block diagram of a computer.

Input 
Unit

Output 
Unit

CU

ALU

MU

Activity Zone:

I.	 Who am I ?
1.	 CPU
2.	 ALU - Arithmetic Logic Unit

3.	 MU - Memory Unit
4.	 CU - Control Unit
5.	 Hardware

II.	 Solve the puzzle:

S

H

O

A

L

UC

F

R

T

D

W

W

A

A

R

Y

R

E

E

M

O

M

Chapter 2. � Computers and your 
Health

Page No. 22-23

I.	 Fill in the blanks with the help of the hint 
box:
1.	 Insulated
2.	 Monitor
3.	 Helpful
4.	 Clean
5.	 18 to 24.

Chapter 3. � INTRODUCTION TO 
WINDOWS

Page No. 31-34

I.	 Choose the correct answer:
1.	 Graphical User Interface
2.	 Desktop
3.	 Taskbar
4.	 Start
5.	 Wallpaper

6
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II.	 Answer the following:
1.	 �The process of loading system files on the 

computer memory is called booting.
2.	 �The basic working platform is called a desktop.
3.	 �An icon is a small picture or image that 

represents an applications.
4.	 �The screen saver is a full screen animated 

image that is displayed on the monitor.
5.	 1. Save all your documents.

2. Click on the start button.
3. Select the shut down command.

III.	 Draw a mind map on the working of a 
computer.

OS

Interface 
bewteen 

user 
and the 

computer

Windows

System 
files on 

computer 
memory

User 
friendly 
environ-

ment

Taskbar

Present at 
the bottom of 
the desktop

Is a small 
picture or 
image that 

respresents 
on 

application

You work, 
you must 
shutdown 

your 
computer 
properly

Icon

Shutdown

Booting Desktop

Activity Zone:

I.	 Complete the cross word

B

g

r

o

u

n

d

t a

c

kd e

w i

s c

s k

s

n

e e n s a

b a r

t o

o w

v e

p

r

II.	 Who am I?
1.	 Taskbar
2.	 Screen saver
3.	 Icon
4.	 Desktop
5.	 Windows

Chapter 4. � CREATING A DOCUMENT 
USING WORDPAD

Page No. 43-46

I.	 Choose the correct answer:
1.	 Word processor
2.	 Both (a) and (b)
3.	 Save
4.	 Backspace and Delete
5.	 Cut

II.	 Answer the following:
1.	 To start wordpad

• Start
• All programs
• Accessories
• Wordpad

2.	 �The flash vertical bar on the screen is called 
an insertion point shortcut key.

3.	 Bold: 1. Select the required text
2. �Click the ‘B’ icon on the standard 

tool (or) use ctrl+B.
4.	 �Remove formatting can be removed by 

clicking on the respective icons again.
5.	 �Copying means to repeat the same 

information in your document at a different 
location.

III.	 Draw a mind map on short cut keys and 
their functions.

Save Ctrl + S Save a document
Bold Ctrl + B Bold the text
Italic Ctrl + I Style the text

Underline Ctrl + U Underline the text
Copy Ctrl + C Copy the text
Paste Ctrl + V Paste the text
Cut Ctrl+X Cut the text

Print Ctrl+P Print a document

7
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Activity Zone:

I.	 Circle the words that are related to word 
processing.

a	 s	 d	 f	 g	 h	 c	 o	 p	 y

l	 e	 p	 r	 e	 u	 i	 n	 m	 v

f	 o	 r	 m	 a	 t	 t	 i	 n	 g

e	 d	 i	 t	 k	 l	 e	 z	 s	 p

k	 c	 n	 g	 j	 m	 x	 b	 l	 d

j	 x	 t	 p	 a	 s	 t	 e	 y	 h

q	 y	 z	 f	 h	 n	 w	 k	 f	 o

w	 a	 s	 d	 i	 r	 q	 x	 e	 m

II.	 Who am I?
1.	 B
2.	 U
3.	 Wordpad
4.	 Wordpad
5.	 Insertion point

III.	 Difference inbetween Notepad and Wordpad.

Notepad Wordpad
Notepad is a text editor, 
meant for basic plain 
text entry.

Wordpad is a word 
processor for formatting 
and printing document.

Chapter 5. � WORKING WITH WINDOWS 
APPLICATIONS

Page No. 56-59

I.	 Choose the correct answer:
1.	 Double click
2.	 Both (a) and (c)
3.	 Title Bar
4.	 Maximize
5.	 File → Edit

II.	 Answer the following:
1.	 To open the calculator

Start → All programs → Accessories → Calculator

2.	 A notepad is a basic text editor.
3.	 �A document area is where your text appears.
4.	 To save a document.

File → Save (or) ctrl+s
5.	 �A small vertical blinking line, which appears 

at the top left corner of the document is 
called a cursor.

III.	 Draw a mind map on the different bars and 
buttons in a Notepad document.

Kind of keyboard keys

Title bar Menu bar Scroll bar Maximize 
button

Document 
area

Minimize 
button

Display 
the 

name of 
document

A menu 
is a list of 

related 
options

It helps to 
navigate 
through 

the 
document

Is used to 
change 

the size of 
window 

to full 
screen

It is 
where 

text 
appears

To reduce 
the size 
of the 

window 
to a small 

button

Activity Zone:

I.	 Label the parts of the Notepad window.
1.	 Title bar
2.	 Menu bar
3.	 Close button
4.	 Minimize
5.	 Scroll bar
6.	 Document area

II.	 Who am I?
1.	 Maximize button
2.	 Close button
3.	 Minimize button
4.	 Title bar
5.	 Restore button

III.	 Colour and Match
1.	 To exit from Notepad	 -	 File → Edit
2.	 To print a file	 -	 File → Print
3.	 To save a file	 -	 File → Save
4.	 To create a file	 -	 File → New

8
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Chapter 6.  MORE ON PAINT
Page No. 71-74

I.	 Choose the correct answer:
1.	 Paint
2.	 Free form select
3.	 Pick colour
4.	 Brush
5.	 Spray

II.	 Answer the following:
1.	 Click the text on the tool box and type your text.

2. Select tool Free form select
Select tool is used to select a 
rectangular area of an image.

Free form tool is used to select 
an irregular portion of an image.

3.	 �Magnifer tool is used for a closer view of an image.
4.	 Click the file menu and select the save ­option.
5.	 �The pick colour tool is used to sample and 

match any colour in your picture.

III.	 Draw a mind map on any five tools and 
their uses.

Mind Map

Text tool

Type 
your text

Pick colour 
tool

Match any 
colour

Magnifier 
tool

Over an 
area of 
which 

you want 
closer view 

Brush 
tool

Used to 
draw 
thick 
lines

Air brush 
tool

Used to 
spray 

painting

Chapter 7.  INTERNET
Page No. 82

I.	 Answer the following:
1.	 �(a) �Internet - Internet is a network that 

connects millions of computers worldwide.
(b) �Webside - A website is a collection of 

publicly accessible interlinked.
4.	 Internet explorer, Google chrome, etc.
5.	 �We can search/download/save images from 

the internet by using search engines.

II.	 Answer the following:
1.	 Web browser
2.	 Internet
3.	 Bing
4.	 Computer
5.	 Windows

Class : 3   KEY ANSWERS

Chapter 1.  HISTORY OF COMPUTERs
Page No. 9-12

I.	 Choose the correct answer:
1.	 Computer
2.	 Abacus
3.	 Difference engine
4.	 ADA
5.	 Punched cards

II.	 Answer the following:
1.	 �It is an electronic machine capable of 

performing basic aerthmetic operation.
2.	 �Difference engine was invented by charles 

babbage.
3.	 �An abacus is the first known calculating 

machine.
4.	 �It used to perform multiplication and 

dicision.

9
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5.	 �The first programming language was 
developed by lady Ada Lovelace.

Activity Zone:

I.	 Who am I ?
1.	 Computer
2.	 Abacus
3.	 Slide rule
4.	 Difference engine
5.	 Rotating wheel calculator

Chapter 2. � INTRODUCTION TO MS WORD
Page No. 20-23

I.	 Choose the correct answer:
1.	 MS-Word
2.	 Microsoft
3.	 Document-1
4.	 Repeat
5.	 Spacebar

II.	 Answer the following:
1.	 �To start MS-Word 

Windows → Scroll Down → Click on word
2.	 �The delete key deletes the characters to the 

right of the cursor.
3.	 �The Undo operation is used to reverse the 

last action performed.
4.	 Page number, Number of words.
5.	 �Selected text can be easily cut and pasted in the 

required location. To move the curser anywhere 
up, down arrows in the keyboard can be used.

III.	 Answer in detail:
1.	 �To save your document: 

(i) Click on the file menu and click on save. 
(ii) A dialog box appears. 
(iii) Name the document by typing in the  
   file name box. 
(iv) Click the save button.

2.	 New document	 -	 Ctrl + N
Save document	 -	 Ctrl + S
Closing document	 -	 Ctrl + W
Opening document	 -	 Ctrl + O
Cut the document	 -	 Ctrl + X
Paste the document	 -	 Ctrl + V

Copy of document	 -	 Ctrl + C
Undo the document	 -	 Ctrl + Z
Redo the document	 -	 Ctrl + Y

IV.	 Draw a mind map to copy the text and 
move it.

Document

Copy

Repeating 
information

Paste document in 
current location

Paste

Activity Zone:

I.	 Match the following:
1.	 New	 -	 Ctrl + N
2.	 Open	 -	 Ctrl + O
3.	 Undo	 -	 Ctrl + Z
4.	 Redo	 -	 Ctrl + Y
5.	 Close	 -	 Ctrl + W
6.	 Exit	 -	 Ctrl + F4

Chapter 3. � INTRODUCTION TO MS 
powerpoint

Page No. 33-35

I.	 Choose the correct answer:
1.	 Microsoft
2.	 Slide
3.	 F5
4.	 Middle
5.	 Esc

II.	 Answer the following:
1.	 �A presentation is a computerised way of 

communicating ideas with the help of text 
and pictures.

2.	 �• Click on the Windows Icon. 
• To find the PowerPoint program 
• Click on the PowerPoint Icon

3.	 �Place holders are the boxes with dotted 
outlines that appear when you create a New 
Slide.

4.	 The F5 key is used to view the Slide show.
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5.	 �• Click on New slide icon from Home Tab (or) 
• Click on Insert Tab from ribbons 
• Choose the new slide option

III.	 Answer in detail:
1.	 �(i) Click on Insert Tab from the Ribbon. 

(ii) Select picture option 
(iii) �Select required picture and click open 

button.
2.	 Powerpoint views.

Powerpoint allows you to view the slides in 
different formate.
There are three types of vies 
(i) Normal view
(ii) Notes page view
(iii) Slide sorter view
(i) �Normal view - This view is divided into 

three panes.
The Outline Pane: This pane can be 
used to enter text in the side.
The Slide Pane: This pane can be used to 
Add text, Graphics, Animation sound etc.
The Notes Pane: This pane is used to 
Add information.

(ii) �Notes Page View - The Notes page view 
is used to enter notes for the slide within 
a presentation.

(iii) �Slide Sorter View - The slide sorter 
view gives you a miniature picture of 
each slide. It also helps in rearranging, 
deleting and adding slides to the 
presentation.

Activity Zone:

I.	 Who am I?
1.	 Normal View
2.	 Notes Page View
3.	 Slider Sorter View
4.	 Slide Show

Chapter 4. � Introduction to ms Excel
Page No. 45-47

I.	 Choose the correct answer:
1.	 Microsoft
2.	 Excel

3.	 Both (a) and (c)
4.	 Active cell
5.	 F2

II.	 Answer the following:
1.	 �• Click the Window Button 

• Type Microsoft Office 
• �Click on the Excel Icon to open MS-Excel 

program.
2.	 �Cell addresses are a combination of a column 

name and a row number. Eg: A1, A2, ... etc.
3.	 A continuous group of cells in a worksheet.
4.	 �The syntax of formula begin with an equal 

sign, followed by a combination of values, 
operations, and cell reference.

5.	 Number, Dates, Times, Text, Formulae.

III.	 Answer the following in detail:
1.	 (i) �Several Mathematical, financial and 

statistical functions and formulae and 
built in.

(ii) The results are accurate.
(iii) The worksheet can be quite big in size.
(iv) �Data can also be viewed in the form of 

graphs.
(v) �Any part of it can be viewed, edited or 

printed.
2.	 1. Click on the file menu.

2. Select the close option.
3. �Click on close button on the top right 

corner of the excel window.

Chapter 5. � More on OPERATING 
SYSTEM

Page No. 52-53

I.	 Choose the correct answer:
1.	 Operating system
2.	 Computer memory
3.	 Apple
4.	 1980
5.	 Two

II.	 Answer the following:
1.	 �An operating system is an interface between 

the user and the computer system.
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2.	 �MS-DOS, Microsoft windows, Apple 
Macintosh, IBM OS12, Unix and Linux are 
examples of operating systems.

3.	 �An operating system that allows only a 
single user to perform a task at a time is 
called a single user.

4.	 �There are two types of operating systems, 
They are:
(i) Single - User - Operating system
(ii) Multi - User - Operating system

5.	 �It is used in computer and laptops that allow 
same data and applications to be accessed 
by multiple user system. Eg: Linux and Unix.

III.	 Explain in detail:
1.	 �As per the interface, operating systems are 

classified into two types: (i) CUI; (ii) GUI
CUI:
1) �Full form of CUI is Character User 

Interface.
2) �It users are required to type the 

commands.
3) It is based on OS. 
4) Eg: Ms-DOS.

GUI:
1) �Full form of GUI is graphical user interface.
2) It is based on OS
3) �It users required clicking on pictures, 

menus, icons using the mouse will 
execute the commands.

4) Eg: Unix, MAC-OS
2.	 1) �MS-DOS - Microsoft Disk operating system.

2) OS - Operating System
3) CUI - Character User Interface
4) GUI - Grap
5) IBM - �International Business Machines 

corporation

Chapter 6. � Introduction to Scratch
Page No. 65-67

I.	 Choose the correct answer:
1.	 Programming
2.	 Stage
3.	 Paint
4.	 Cat
5.	 Animations and games

II.	 Answer the following:
1.	 �Scratch is a programming language we can 

create animation and games with ease. 
Using scratch.

2.	 1) Click on the windows button
2) Scroll down to find scratch
3) Click on scratch

3.	 �Sprite is added on the stage everytime we 
open scratch.

4.	 �This Menu Consists of different menus to 
choose from where each block has a unique 
function.

5.	 �Duplicate: To make a copy of the currently 
selected sprite.
Delete: To remove a sprite from the stage.

III.	 Explain in detail:
1.	 �To create a sprite in scratch by clicking the 

icon.
2.	 �Clicking on this icon will open the paint 

editor.
3.	 �Use the Basic shapes and colour options to 

draw and paint.

IV.	 Draw a mind map on Scratch and its 
interface.

Sc
ra

tc
h 

an
d 

its
 In

te
rf

ac
e

Sprite Object we add on stage area

Stage 
area Add various backgrounds

Sprite 
area Will have the icons of all sprites

Script 
area Blocks pallete are add to the script area

Blocks 
pallette

Consists of various blocks can be add 
in script

Blocks 
menu

Consists of different menu has a unique 
function
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Chapter 7. � Programming using 
Scratch

Page No. 77-79

I.	 Fill in the blanks:
1.	 Change effect
2.	 forever
3.	 Pendown
4.	 Play sound
5.	 Keyboard

II.	 Match the following:

Block Function
Think blocks DISPLAYS thought bubbles with text in them 

from a Sprite.
Move block Moves the Sprite either in the forward or 

backward direction based on a given value. A (-) 
symbol preceding the value will move the Sprite 
backward. 

Next costume controls the action to be performed by Scratch 
once the Green Flag icon is clicked.

When Green 
Flag clicked

changes the costume of the Sprite  in an order 
as per the availability of the Costumes in the 
Costumes tab.

Glide block Performs a glide action on the Sprite for a given 
amount of time until the given set of points is 
reached on the Stage.

III.	 Answer the following:
1.	 �These blocks are used to display a message 

on the stage.
2.	 �This block controls the action to be 

performed by scratch.
3.	 �Move the sprite either in the forward or 

backword direction based on the gives value.
4.	 �This block clears all the drawings made by 

the pen down black from the stage.
5.	 �These blocks are used to set the position of 

a sprite.

IV.	 Answer in detail:
When  clicked
clear
Pendown
Set pen colour to 
Repeat 20

move 5 steps
coat 0 - 2 sec
move 10 steps
next costume
point in direction 
set pen colour in 
repeat 20
move 5 steps
wait 0 - 2 secs
move 10 steps
next costume
wait 0 - 2 secs
next costume
point in direction - 90
set pen colour to 
repeat 90

move 5  steps
wait 0.2  sec
move 5  steps
next costume
wait 0 - 2 secs
next costume
point in direction 180
set pen colorte 
repeat 20
move 5  steps
wait 0 - 2 secs
move  5  steps
next costume
wait 0 - 2 secs
next costume
point indirection 90∇

Chapter 8. � Search Engines and 
Keywords

Page No. 86-87

I.	 Fill in the blanks:
1.	 Search results
2.	 Search engine
3.	 Keywords
4.	 Search suggestion
5.	 Special characters
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II.	 Answer the following:
1.	 �Serach engines make it easier to find and 

access this information.
2.	 �Keywords are also known as search terms 

and then press enter on your keyboard.
3.	 �Search engines let the users search for 

­specific information such as Imges, Audio 
and Video.

4.	 (i) Search result
(ii) Search suggestions
(iii) Refinning your search
(iv) Content specific searches
If you are having difficulty thinking of new 
search terms. Search suggestions can be used.

III.	 Answer in detail:
1.	 �Use search engines to search for information 

on the internet.
2.	 �Use keyboards entered by the user to search 

for information on the internet.
3.	 �Search engines let the users search for con-

tent specific information of Images, Audio 
and Video.

Class : 4   KEY ANSWERS

Chapter 1.  GENERATIONS OF COMPUTERS
Page No. 10-12

I.	 Choose the correct answer:
1.	 Five
2.	 Machine
3.	 Cobol, Fortran
4.	 Transistors
5.	 Third

II.	 Answer the following:
1.	 �Vaccum tubes was used in the first 

generation of computer.
2.	 (i) The transistor was a far superior technology

(ii) �It relied on punched cards for input and 
printouts for output.

3.	 �They were large in size. It occupied a lot of 
space and produced enormous heat.

4.	 �IBM 1401 and CDC 3600 are examples of 
second generation computers.

5.	 AI - Artificial Intelligence software.

III.	 Answer the following in detail:
1.	 Basic	 -	 Basic Integrated Circuits

VLSI	 -	 Very Large Scale Integration
ENIAC	 -	� Electronic Numerical Integrator 

and Calculator
UNIVAC	-	� Universal Automatic Computer
AI	 -	Artificial Intelligence

2.	 �First generation → Vaccum tubes → 
Machine language
Second generation → Transistors → High 
level language
Third generation → Integrated circuits → 
High level language
Fourth generation → Microprocessor → 
High level language
Fifth generation → Artificial Intelligence → 
High level language

IV.	 Draw a mind map of the generations with 
their components.

Generation of Computer

First

Vaccum 
tube

Second

Transistor

Third

Integrated 
circuits

Fourth

Micro 
processor

Fifth

Artificial 
Intelligence

Chapter 2.  MORE ON MS WORD
Page No. 22-24

I.	 Choose the correct answer:
1.	 Ctrl + B
2.	 Insert → Picture → From file
3.	 Word Art
4.	 Rows and Columns
5.	 Ctrl + E

14

EntertheWorldofIT_KeyBook_2023.indd   14 28-06-23   11:50:51 AM



II.	 Answer the following:
1.	 �Formating text in Microsoft Word refers 

to controlling how text appears in your 
document. This includes the size, colour 
and font of the text.

2.	 (i) Select the text you want to modify.
(ii) Home tab → Click drop down → Font box
(iii) Font style → Select
(iv) Font will change in document

3.	 �A set of type characters that are darker and 
havier than normal.

4.	 (i) �Select the table by clicking the move 
handle that appears above the top left 
corner of the table.

(ii) �Select on alignment option in the 
paragraph group on the Home tab.

III.	 Answer the following in detail:
1.	 �Bold - It refers to the text in the same font 

and in the same size.
Ctrl + B = Bold

Italics - To change the words to Italics, select 
the word and press the Italic Button

Ctrl + I = Italic
Underline - To underline a word, select the 
word and press the underline icon on the 
Home tab.

Ctrl + U = Underline
2.	 (i) Go to Design → Page borders

(ii) Make selections → Want to border to look
(iii) �To adjust the distance between the 

border and edge of the page
(iv) Select OK

IV.	 Draw a mind map on paragraph alignment.

Paragraph Alignment

Ctrl + L

Left Right Center Justify

Ctrl + R Ctrl + E Ctrl + J

Chapter 3.  MORE ON MS POWERPOINT
Page No. 30-31

I.	 Choose the correct answer:
1.	 Sound
2.	 A Single Slide
3.	 Dissolve
4.	 Blinds Vertical
5.	 Strips up-right

II.	 Answer the following:
1.	 �A theme is a template with a specific design 

that can be applied to a slide.
2.	 (i) �Select the slide for changing the 

background
(ii) Click on the design tab
(iii) Click on format background option

3.	 �Slide transition is the animation way in 
which slides appear one after the other in a 
slide shows.

4.	 �Custom Animation is used to animate 
different objects in the slide during a slide 
show.

5.	 �Wordart is a decorative way to represent 
headings in different styles.

III.	 Answer the following in detail:
1.	 To apply a theme to a slide

(i) Click on the design tab
(ii) Select themes group and select the 
theme of your choice.

2.	 (i) Select the slide to apply transition affect.
(ii) Go to the transition tab
(iii) �Select any transition effect from given list
(iv) �Selected transition happening to the slide

3.	 (i) Click on the insert tab
(ii) Click on the wordart button, choose any style
(iii) The wordart text box appears
(iv) Type the text
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IV.	 Answer the following in detail:

Tr
an

si
tio

n 
Ef

fe
ts

Blinds Vertical

Chacker Board

Box Out

Cover Right-Up

Dissolve

Split Horizontal In

Split Vertical Out

Strips Up-Right

Uncover Up

Wipe Left

Wipe - Down

Chapter 4.  MORE ON MS EXCEL
Page No. 42-43

I.	 Choose the correct answer:
1.	 Left
2.	 =
3.	 Both formula and functions
4.	 Column width
5.	 = Sum (A1 : A5)

II.	 Answer the following:
1.	 �Text, Numbers, Date, Mathematical, Formula 

can be typed in a cell.
2.	 Left, Center, Right, Top, Middle, Bottom.
3.	 Function is a Pre-defined Formula Built in excel.
4.	 �Addition, Subtraction, Multiplication, 

Division, Exponentiation, Percent.
5.	 �Charts can present Data and information in 

an Attractive and compact manner.
Charts are easier to understand and compare 
and they convey the messages quickly.

III.	 Answer the following in detail:
1.	 B - This icon is used to display the data in bold.

I - This icon is used to display the data in Italics.
U - This icon is used to underline that data.
A - �This icon shows a colour palettes can be 

used to change the font colour.
$ - �Display the contents of the selected cells 

in default format.
% - �Display the current contents in 

percentage format.
2.	 �Fill command is used to generate a data 

­series based on a defined pattern.
Eg: �Type 2 in cell A1 

Type 4 in cell A2 
Highlight the cell and drag down with 
the mouse

3.	 Chart offer a visual presentation of the data.
Types of charts
1. �Bar chart - Compare value and placeless 

emphasis on ???
2. �Column chart - Change in data over a 

period of ???
3. �Line chart - Shows trends in data at equal 

intervals.
4. �Pie chart - Shows the proportional size of 

items.

IV.	 Draw a mind map on the functions used in 
Excel.

Function

Sum ( )

Add

Average ( )

Average

Maximum ( )

Largest 
value

Minimum ( )

Smallest 
value

Insert ( )

Integer 
part

Chapter 5. � INTRODUCTION TO 
MEMORY UNIT

Page No. 49-50

I.	 Choose the correct answer:
1.	 Bytes
2.	 Binary digit
3.	 Read / Write
4.	 2
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II.	 Answer the following:
1.	 �The memory unit of a computer stores data 

and instructions required by the computer.
2.	 �The memory unit of a computer consists of 

two types, they are
1. Internal memory
2. External memory

3.	 �Hard disks are storage devices that hold 
huge memory space. 
Flopy disks is a removable magnatic 
storage medium allows recording of data

4.	 �The secondary storage devices are Hard 
disks, CDs, Pendrive and external hard disk.

III.	 Answer the following in detail:
1.	 �8 bits = 1 byte 

1024 bytes= 1 kilo bytes (KB) 
1024 KB = 1 megabite (MB) 
1024 MB = 1 gigabite (GB) 
1024 GB = 1 terabite (TB)

2. RAM ROM
1. It is not permanent It is permanent
2. It stores program are 

currently being used by 
the computer

It stores startup 
instruction

3. It is a volatile memory It is a non-volatile memory

IV.	 Draw a mind map on memory and its 
categories.

Function

Sum ( )

ROM RAM Pen drives Hrad disk Compact 
disk (CD)

Minimum ( )

Chapter 6. � Conditional Statements 
in Scratch

Page No. 59-60
I.	 Choose the correct answer:

1.	 Sprites
2.	 Repeat until
3.	 Wait until

4.	 Forever
5.	 Control

II.	 Answer the following:
1.	 �Conditional statements have slots that are 

shaped with points on either side with is 
true or false.

2.	 �They are found in the control programming 
blocks as shown below. If ( ) then and if ( ) 
then else are conditional blocks.

3.	 �This block is an extension of the if then 
value. If condition is true then a lines get 
executed.

4.	 �The forever block is used to run a program 
again and again without any mouse click.

5.	 �The if ( ) then block is a control block and If 
its boolen condition is true. The blocks held 
inside it will run.

Chapter 7. � Broadcast and Receive in 
Scratch

Page No. 66-67
I.	 Choose the correct answer:

1.	 Signals
2.	 << when I receive>>
3.	 Control
4.	 When I Receive
5.	 Broadcast

II.	 Answer the following:
1.	 �Technique of sending and receiving signals 

is called Broadcast.
2.	 (i) �Determine your set top box device has 

HDM1 connection.
(ii) �Once successfully located the HDM1 

port on device proceed to HDM1 cable.
3.	 Broadcast

• Broadcast block
• Broadcast and wait block
Receiving
• When I Receive Block

4.	 �We use the <<when I Receive>> block to 
receive the broadcast.

5.	 �Broadcast block that is present under 
control menu.
Broadcast and wait block  works to wait 
until all scripts activate by broadcast end.
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Chapter 8. � the world of EMAIL
Page No. 75-76

I.	 Fill in the blanks:
1.	 Electronic mail
2.	 1980’s
3.	 ARPANET morphed
4.	 Username and Domain
5.	 Unique

II.	 Answer the following:
1.	 �Email is a computer based application for 

the example of messages between user.
2.	 �The first message was sent from ­computer 

to computer on Arpanet 1971, Ray to 
milinson developed email.

3.	 �Email content are primary classified as 
headers and the body details about the 
message such as the unique identify of the 
message.

4.	 �It is ‘@’ sign is a divider in the email address 
and it reports the username from the service 
provider’s name.

5.	 �It is the name you choose to be identified 
with for email purposes and that you have 
provided to the email.

II.	 Answer in detail:
1.	 Open the Gmail account creation website
2.	 Click create an account button
3.	 Enter your first and last name
4.	 Create a Gmail - username
5.	 Enter a password twice
6.	 Click next button
7.	 �Skip the phone number, recovery email ad-

dress shown
8.	 Add your date of birth
9.	 Select a gender
10.	Click on the next button
11.	Click on the I Agree
12.	Account page opened

Class : 5   KEY ANSWERS

Chapter 1.  TYPES OF COMPUTERS

Page No. 12-13

I.	 Choose the correct answer:

1.	 Digital
2.	 Laptop
3.	 Workstation
4.	 Note book
5.	 Mainframe

II.	 Answer the following. 

1.	 Analog computers perform computing 
operations  based on a varying range of values.

2.	 • Speed
• Accuracy
• Automation

• Endurance
• Versatility

3.	 A hybrid computer is a computing system 
that combines both digital and analog 
components.

4.	 Laptop Computers are portable computer,  
that fit in a briefcase or in a backpack  that 
can be carried around.

5.	 • PARAM Series	 • CRAM Series
• CYBER Series	 • FUJITSU Series

III.	 Answer the following detail. 

1.	 Classification of computers based on the 
Principles of operation are,
• Analog Computer 
• Digital Computers
• Hybrid computers

Analog Computers: Perform ­computing 
operation based on a varying range of 
values.
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Digital Computer: operate on digital data 
such as numbers.

Hybrid computers: Is a computing ­system 
that combines both digital and analog 
components.

2.	 • weather forecasting.
• Space research.
• weapon research. 
• atomic research.
• design of aircrafts.

IV.	 Draw a mind map on the classification 
of digital Computers based on their 
configuration.

Classification of digital computer 
Based on their Configuration

Micro 
computer

Mini 
computer

Mainframe 
computer

Super 
computer

Chapter 2. �IN TRODUCTION TO 
MS ACCESS

Page No. 24-25

I.	 Fill in the blanks:

1.	 Computer based data bases
2.	 Datasheet
3.	 Tables, Queries, reports
4.	 Database
5.	 Database from template and Create blank 

database.

II.  Match the following:
1. Record Shows only the information you want. It 

is also the end result of a query. 
2. Database Organized collection of your data.
3. Query Information (all fields/columns) for 

every individual item in a file.
4. Report Request that you make to extract only the 

information you want.
5. Form A user-friendly interface  

used for entering or displaying data.

III.	 Answer the following:

1.	 �A database is an organized collection of 
your data.

2.	 a) �Record - Information for every individual 
item in a file is called a Record.

b) �Report - A report is similar to a form, 
but it only shows the information you 
want.

c) �Field - A record is divided into separate 
headings known as fields.

3.	  i) Start by launching MS Access.
 ii) �Select Blank desktop database. Enter 

the name for your database and click the 
create button. 

iii) Access will create a new blank database. 
4.	 �A query is a request you make of your data, 

to extract only the information you want.
5.	  i) �Maintain all information for each 

individual.
 ii) �Track data without needing a separate 

Software program.
iii) �Run reports and analyses using the 

reports and charts.

IV.	 Answer the following in Detail:

1.	 Refer the book page no. 23.

Chapter 3. � Creating Tables in 
MS Access Database

Page No. 37-38

I.	 Fill in the blanks:

1.	 Data type
2.	 Short Text
3.	 8 bytes 
4.	 2
5.	 Primary key
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II.	 Match the following:

1. Short Text Assign a unique number or assigned 
by Microsoft Access when any new 
record is created. Usually used as the 
primary key.

2. Long Text Text, including numbers which does 
not need calculation. (e.g., Mobile 
numbers).

3. Number It allows you to store currency values 
and numeric data with one to four 
decimal places.

4. Date/Time Store date/time for the years 100 
through 9999.

5. Currency This data type is used for 
lengthy text or alphanumeric 
data.

6. Auto Number Used for storing mathematical 
calculations.

III.	 Answer the following: 

1.	 �Primary is the column(s) that contain values 
that uniquely identify each row in a table. 

2.	 i) Creating table in Datasheet View
ii) Creating table in Design view.

3.	 �Primary key helps us find the required data  
as the field marked as primary key will have 
no repeated data.

4.	 a) �Date- store date/time for the years 100 
through 9999.

b) �Yes/No - It only stores Logical values Yes 
or  No.

c) �Hyperlink - Text or combinations of text 
and numbers stored.

5.	 �Design View. Design view can make it easier 
to set up a table.

IV.	 Answer the following in Detail: 

Refer the book Pg No: 29-33

Chapter 4. � Introduction to 
Network

Page No. 47-50

I.  Choose the correct answer:
1.	 Communication channels
2.	 4
3.	 WAN
4.	 5
5.	 Bus

II.  Answer the following:

1.	 �A network is formed when a group of 
computers and devices are connected 
together for various purposes such as 
communication, sharing information and 
resources.

2.	 �Network topology is the structure or layout 
by which  the nodes in a network are 
collected.

3.	 Communication channels for:
PAN - Bluetooth and Wi-Fi
LAN - cables
MAN - Either cables or  satellites 
WAN - Mostly satellites.

4.	 �The size, ownership, physical architecture 
and the distance it covers determine the 
category of a network. 

5.	 PAN - Personal Area Network.
MAN - Metropolitan Area Network
WAN - Wide Area Network

III.	 Answer in Detail:
1.	 Advantages

A network allows:
• �Ordered flow of information among 

computers.
• Sharing of files and folders.
• �Sharing of hardware and software ­devices 

and applications.
• �Provides a communication link between 

users  in a network.
2.	 Refer the diagram  book  page no. 40, 41, 42
3.	 Refer II Ans 2

Refer book page no.43-45
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IV.	 Draw a mind map on the different types of 
network.:

Types of Network

PAN LAN MAN WAN

Activity Zone

I.	 Who am I?

1.	 PAN
2.	 LAN
3.	 MAN
4.	 WAN

Project Activity 

II.	 Match the following:

Mesh topology

Bus topology

Ring topology

Star topology

Tree topology

Chapter 5. � Introduction to 
Internet

Page No. 56-58

I.	 Choose the correct answer:

1.	 Tim Berners Lee
2.	 ISP
3.	 home page
4.	 e-mail
5.	 @

II.	 Answer the following:

1.	 �Internet is a network of networks with millions 
of computers that are connected to each other.

2.	 �A modem (modulator-demodulator) is a 
­computer peripheral that can be fixed ­externally 
inside the CPU or it can be  attached separately.

3.	 • Micro Soft Edge.
• Mozilla Firefox.
• Safari
• Google chrome
• Opera
4.	 �A web browser is a program that is used to 

surf the Internet.
5.	 �Using an e-mail, You can send text, pictures,  

sounds,  programs or even movies to any 
other person on the internet, anywhere in 
the world.

III.	 Answer in Detail:

1.	 �ARPANET - �Advance Research Projects 
Agency Network..

ISP - Internet Service Provider
Modem - Modulator-demodulator
www - World Wide Web.
e-mail - Electronic mail.

2.	  ✓ Requirements for an internet Connection
• a computer
• A Telephone,  Cable line or a dongle
• A modem
• An account with an ISP
• A web browser.  ex. Internet Explorer
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3.	 Step 1: �Login your Gmail account, using id 
and password.

Step 2: click compose button
Step 3: �Add recipient e-mail id in the To 

field.
Step 4: �At the  bottom of the page, there is a 

Send option.  click Send to send mail.
4.	 Create Gmail account, 

Step 1: Visit Google account Creation page.
Step 2: Click on Create account.
Step 3: �The sign- up form will appear. Enter 

your first and last name.
Step 4: Choose a user name.
Step 5: Enter s password
Step 6: Enter your Phone number,
Step 7: Enter DOB.
Step 8: Choose a Gender.
Step 9: Click on I agree.

Chapter 6.  Basics of Robotics

Page No. 70

I.	 Answer the following:  

1.	 �A robot is a machine, probably resembling 
either a human or an animal, which is ca-
pable of carrying out certain tasks that 
humans usually do or even certain tasks 
that humans find it ­difficult to do.

2.	 �A robot is typically made either of plastic or 
of metal. There are mainly three parts in a 
robot.
• Controller
• Mechanical parts
• Sensors

3.	 �Nanorobotic or nanobots are robots scaled 
down to microscopic size in order to put 
them into very small spaces to perform a 
function.

II.	 Answer in detail

1.	 �A sensor  is used to sense / preceive the 
external as well as internal environment 
Types of Sensors.

• External Sensors
• Internal Sensors
• �External Sensors: These help sense 

elements like light touch, sound and proximity.

• �Internal sensors: These sensors are 
required to measure the internal state of 
the robot.

Ex: The automatic driving program in 
cars  by Tesla.

2.	 • Education 
• Exploring outer space 
• Hospitals
Education:  Many robots such as cyber - 
pets are used in colleges. Humanoid robots 
take Learning to the next step.
Exploring Outer Space: Robots can also be 
used in places that have unfavorable  condi-
tions for humans, live studying  outer space 
for example. AI based support systems.
Hospitals: Scientists are already on the task 
to make robots that are similar to tasks like 
delivery drugs to precise locations in the 
human body, conducting routine monitoring 
of patients and other similar tasks.

3.	 Refer the book page no. 67-69

Chapter 7. �IN TRODUCTION TO 
MULTIMEDIA

Page No. 76-77

I.	 Choose the correct answer:

1.	 Two
2.	 Text 
3.	 video
4.	 Analog wave 
5.	 both a and b.

II	 Answer the following.

1.	 �Multimedia is a computer based 
presentation technique that incorporates 
text, graphics, sound, animations and. video 
elements
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2.	 �Animation refers  to the simulation of 
movement created by displaying a series of 
pictures, one after the other.

3.	 �Media means the way through which one 
can convey information.

4.	 Name Some popular animated films.
• Finding Nemo
• Polar Express
• Ice Age
• Sindbad

5.	 CBT - Computer Based Tutorials. 
WBT - Web Based Tutorials

III.	 Answer the following in detail:

1.	 �Multimedia applications are also widely 
used in the fields of engineering ­medicine 
and ­Scientific research. For example, in 
engineering, multimedia tools are used for 
designing and testing new components 
and products.  In medicine, doctors can be 
trained by viewing  a Virtual surgery or by 
simulating a Surgical procedure, without 
endangering the life of a human being. A 

scientist can look at the molecular model of 
compound and manipulate it.

2.	 Components of Multimedia:
• Text
• Images
• Sound
• Animation
• video
Text: Text is the primary component of 
multimedia. Most of the  information is 
conveyed through the text.
Images: Images play a key role in 
multimedia. It is easier to e-learn and retain  
information from images.
Sound: Sound is a very important aspect 
of multimedia. The sound that you hear are 
analog wave patterns.
Animation: Animation are primarily used 
to illustrate or demonstrate an idea or a 
concept.
Video: Video refers to live images in motion, 
recorded with the help of a camera.

Class : 6   KEY ANSWERS

Chapter 1.  Computer Fundamentals

Page No. 13

I.	 Choose the correct answer:

1.	 a) Computers
2.	 c) Input 
3.	 d) brain
4.	 b) three 
5.	 a) Byte

II.	 Match the following:

1. Input device To feed data or instructions into the 
computer

2. Output device Monitors and printers
3. RAM Read/Write memory

4. Secondary 
storage

Floppy

5. CPU Brain of the computer

III.	 Answer the following questions in one or 
two words:
1.	 • Touch Screen.

• Barcode reader
• Digital camera
• Scanner

2.	 • Monitor
• Printer
• Speaker

3.	 • Memory Unit 
• Control Unit
• Arithmetic and logic unit

4.	 • Internal memory or primary memory
• External memory or secondary memory

5.	 �ROM -  stands for Read Only Memory.
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IV.	 Answer the following questions briefly:

1.	 �A hard disk is a computer’s permanent stor-
age device.  

2.	 �RAM is also  called Read/Write memory. 
Since we can write information into this 
memory and also read from it. The moment  
you switch off the computer, the information 
in RAM will be erased. 

3.	 �Information stored in ROM is permanent.  
They are not erased even when the power 
goes off. Hence, it is called nonvolatile 
memory.

4.	 �The devices used to store information 
permanently are called  secondary storage 
devices.

5.	 �The Information and instructions typed 
through the keyboard and the output of 
programs are displayed on the monitor. A 
monitor is also called a Visual Display unit 
or  VDU in short.

Chapter 2. � UNDERSTANDING 
WINDOWS

Page No. 25-26

I.	 Choose the correct answer:

1.	 b) Hardware
2.	 a) Software 
3.	 c) operating system
4.	 b) GUI
5.	 a) desktop

II.	 Answer the following questions in one or 
two words:

1.	 • Application Software
• System Software

2.	 • MS DOS
• Windows
• UNIX
• LINUX 
• MAC OS

3.	 GUI Stands for Graphical User Interface

4.	 • Floppy disk drive
• Keyboard
• Printer
• Monitor
• Mouse

5.	 i) Click Start, select search option 
	 ii) Type explorer in the search box.
	 iii) Windows Explorer window will appears.

III.	 Match the following:

1. Operating 
system

Allows to interact with the computer 
hardware

2. Booting Process of loading the operating system
3. File Collection of information
4. Desktop Place holder for the icons and taskbar
5. Icons Small pictures seen on the desktop

IV.	 Answer the following questions briefly:

1.	 �The Input, Output and Secondary storage 
devices are called Peripheral devices.

2.	 • �Transfers commands given through the 
keyboard and mouse.

• Sends data to the screen or printer.
3.	 �Windows is a popular Operating system 

which works on the concept called GUI.
4.	 �Once a file is created, a unique file name is 

given to it and stored. This distinct name helps 
in identifying the file easily, in the feature.

5.	 �A folder is used to store a collection of files. A 
folder is necessary to classify files according 
to their content.

Chapter 3. MS - EXCEL – CHARTS

Page No. 32-33

I.	 Fill in the blanks: 
1.	 Chart
2.	 5
3.	 Pie
4.	 Line
5.	 Bar/column
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II.	 Answer the following:

1.	 �A chart is a visual representative of data in both 
columns and rows.

2.	 �Charts are usually used to analyse trends and 
patterns in data sets.
You can also draw charts to compare other enti-
ties based  on the data that you have entered in 
Excel sheet.

3.	 • Pie chart
• Bar chart
• Column chart
• Line chart
• Combo chart

4. Bar Chart Line Chart
When you want to 
compare values across 
a few categories

When you want to 
visualize trends over 
a period of time.

5.	 • Allows you to visualize data graphically.
• Easier to analyse trends and patterns.
• Easy to interpret compared to data in cells.

III.	 Answer in detail:
Step 1: Select the data.
Step 2: Click on the Insert tab  from the ribbon.
Step 3: Click on the Pie chart dropdown button.

Pie chart displayed on the screen.

Chapter 4.  �MS-ACCESS DATA ENTRY 
AND QUERY

Page No. 41

I.	 Fill in the blanks:

1.	 Tables, forms, reports and queries
2.	 Query
3.	 Run, design
4.	 Datasheet
5.	 View

II.	 Answer the following:

1.	 �A query is a request for a specific data ­results.
2.	 • �Select the View Datasheet view option in 

the ribbon.
	 • You can type data into one or more fields.
3.	 �After creating a query, go to the Design tab 

and click Run option.
4.	 • Select queries

• action queries
5.	 • �View data only from the fields you are 

interested in viewing. When you open a 
table, you see all the fields.

• �View records that meet criteria that you 
specify.

Chapter 5. � Introduction to 
programming 

Page No. 46

I.	 Fill in the blanks: 

1.	 Computer program
2.	 Machine language
3.	 Binary language
4.	 Machine language
5.	 python
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II.	 Answer the following: 

1.	 �Programming is the act of instructing 
computers to carryout tasks.

2.	 �Programming language are high level 
languages that are written in human 
readable format.

3.	 �Machines have their natural language like 
humans do. Computers do not understand 
the human language. The natural language 
of computers is the binary code 0 and 1. 
These represent two states on and off. This 
is called the machine language or the binary 
language.

4.	 • Interpreters
• Compilers
• a hybrid of interpreters and compilers
• assemblers

5.	 �Translators convert the source code to 
machine language.

III.	 Answer in detail:

1.	 �Translator – Convert the source code to 
machine language.
Types of Translators:
• Interpreters
• Compilers
• a hybrid of interpreters and compilers
• assemblers
Interpreters: The translator processes the 
source code line by line, and runs every line 
in the final program.
Compilers: One of the translator, it converts 
the source code entirely to binary via a com-
pilation process.
Hybrid translator: A hybrid translator 
is a combination of both interpreter and 
compiler.
Assembler: Convert assembly language 
into binary language.

2.	 �Programming is the act of instructing com-
puters to carryout tasks. It is often referred 
to as coding.

	� Computer Program: A computer program 
is a sequence of instruction that the 
computer executes, to achieve a particular 
output or to complete a task.

	� Examples: Top five programming ­languages 
currently are, Java, Python, Javascript,  
C/CPP, PHP.

Chapter 6. �AL GORITHM AND 
FLOW CHART

Page No. 51

I.	 Fill in the blanks:

1.	 Algorithm and Flowchart
2.	 Flowchart
3.	 Problem
4.	 Algorithm
5.	 Terminal box

II.	 Answer the following:

1.	 �A flowchart is the graphical or pictorial 
representation of a given problem.

2.	 �Algorithm is a step-by step procedure to 
solve a given problem.

3. 1. Terminal box

2. Input / Output

3. Process

4. Decision

5. Connector

4. Algorithm Flowchart
It is a procedure for solving 
problems.

It is graphic representation 
of a process.

It is easier to solve complex 
problem.

It is hard to solve complex 
problems.

5.	 Find the smallest of two numbers.
Step 1: Start the program.
Step 2: Read a and b
Step 3: �Check if a is less than b, then print a 

is smallest number.
Step 4: If false Print b is smallest number.
Step 5: stop the program.
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III.	 Answer in detail:

1.	 Refer the book Page No.49
2.	 Refer the book page No. 49 & 50.

Chapter 7. �IN TRODUCTION TO 
‘C’ PROGRAMMING

Page No. 61

I.	 Fill in the blanks:

1.	 C programming
2.	 1972, Dennis M. Ritchie
3.	 UNIX
4.	 ANSI [American National Standard Institute]
5.	 Linker

II.	 State True or False:
1.	 TRUE
2.	 TRUE
3.	 FALSE
4.	 FALSE
5.	 TRUE

III.	 Answer the following:
1.	 �C programming  is a general purpose, pro-

cedural and important computer program-
ming language.

2.	 Refer Book Pg.No 52
3.	 Refer Book Pg.No. 52, 53
4.	 Token is the smallest individual element in C.

IV.	 Answer in Detail:
1.	 Refer Book Pg.No. 59
3.	 Refer Book Pg.No. 53

Chapter 8. �IN TRODUCTION TO 
ROBOTICS

Page No. 69

I.	 Fill in the blanksL

1.	 Asimov
2.	 �Adept’s SCARA robots, Cognex in-sight robot,  

Barrett technology manipulator
3.	 Law 3
4.	 Four
5.	 Two

II.	 Match the following:
2, 3, 1, 0

III.	 Answer the following:
1.	 �Robot is a reprogrammable, multifunctional 

manipulator, designed to move material, 
parts, tools or specialized devices through 
variable programmed motions for the 
performance of a variety of tasks.

2.	 Refer Book Pg.No 66
3.	 �Adept’s SCARA robots, Cognex in-sight ro-

bot,  Barrett technology manipulator
4.	 Refer Book Pg.No.68
5.	 Refer Book Pg.No.65

IV.	 Answer in detail:
1.	 Refer Book Pg.No 66
2.	 Refer Book Pg.No. 68

Chapter 9. �IN TRODUCTION TO 
CIRCUITRY USING 
MICROCONTROLLERS

Page No. 76

I.	 Fill in the blanks

1.	 Circuitry
2.	 micro controller
3.	 BBC
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II.	 State True or False:
1.	 TRUE
2.	 FALSE
3.	 TRUE
4.	 FALSE
5.	 TRUE

III.	 Answer the following:
1.	 �Circuitry is a system of electric circuits 

through which signals can travel from one 
component to another.

2.	 �A microcontroller is a board that consists 
of many components that are connected to 
each other.

3.	 �micro:bit is a pocket-sized computer that 
introduces you to how software and hard-
ware work together.

4.	 �Buttons, LED display & light sensor, Pins – 
GPIO, Pin-3 volt power, Pin-Ground, Touch 
logo, Microphone LED – new, Programming 
the micro:bit

IV.	 Answer in detail:
1.	 Refer Book Pg.No 72, 73
2.	 from microbit import *

# Define smiley face pattern
smiley_face = Image(“00000:”
                   “09090:”
                   “00000:”
                   “90009:”
                   “09990”)

# Display smiley face
display.show(smiley_face)
sleep(2000)  # Wait for 2 seconds

# Display message “Coding is fun!”
display.scroll(“Coding is fun!”)

Smiley Fun with Coding
Write down the code to display the message 
“Coding is fun!” using a micro:bit, following 
a smiley face.
from microbit import *
# Define smiley face pattern
smiley_face = Image(“00000:”
                   “09090:”
                   “00000:”
                   “90009:”
                   “09990”)
# Display smiley face
display.show(smiley_face)
sleep(2000)  # Wait for 2 seconds
# Display message “Coding is fun!”
display.scroll(“Coding is fun!”)
This code first defines a smiley face pattern 
using a 5x5 grid of pixels.
The Image() function is used to create a 
custom image using 0s and 9s. Each 0 rep-
resents an off pixel, and each 9 represents 
an on pixel. 
The smiley face pattern is then displayed 
on the LED screen using the display.show() 
function.
After displaying the smiley face for 2 sec-
onds (sleep(2000)), the code uses the dis-
play.scroll() function to scroll the message 
“Coding is fun!” across the LED screen.

Class : 7   KEY ANSWERS

Chapter 1. � Working Principles of 
a Computer

Page No. 8-9

I.	 Choose the correct answer:

1.	 A) System Unit
2.	 C) Both a and b

3.	 C) Main Memory
4.	 B) 3
5.	 B) Trouble Shooting

II.	 Fill in the blanks:
1.	 PS/2
2.	 Mother Board
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3.	 Expansion Card
4.	 Serial,  Parallel
5.	 ROM

III.	 Expand the following:
1.	 BIOS – Basic Input Output System
2.	 USB – Universal Serial Bus
3.	 UPS – Uninterruptible Power Supply
4.	 VGA – Video Graphic Adaptor
5.	 PS/2 – Personal System / 2

IV.	 Answer the following:
1.	 �The mother board is the main board that all 

the other internal components connect to.
2.	 �System unit, also known as the base unit, is 

the main body of a desktop computer.
3.	 �The Basic Input Output System tests all the 

critical components to ensure that they 
function properly.

4.	 �The storing of frequently used data in an 
extremely fast RAM, that connects directly 
to the CPU, is called Caching.

5.	 �A port is a connector where you plug in an 
external device such as a key board, monitor, 
printer, mouse and micro phone.

6.	 �Uninterruptible power supply is a device 
that supplies power to connected equipment 
from a separate source in the absence of 
utility power.

7.	 �Virtual memory is the space on a hard disk 
used to temporarily store data and can be 
swapped, in and out of the RAM as needed.

8.	 �An expansion card is a circuit board that 
lets you add new features to a computer.

V.	 Answer in Detail:
1.	 �The CPU is the brain of the computer. It 

controls the overall activities of a computer.
	 • �The CPU consists of the control unit, ALU 

(Arithmetic and Logic Unit), a memory 
unit and various temporary buffers.

	 • �The ALU is the part of the CPU where are 
computation takes place.

	 • �The control unit controls all the hard 
ware operations.

	 • �The MU stores the program and data that 
are currently being used.

2.	 Refer the book: Page No.7

VI.	 Mind Map:

Chapter 2. �L ogical Functions in MS-Excel

Page No. 20-21

I.	 Answer the questions:
A. = AND(A2>A3, A2<A4) – False
B. = OR(A2>A3, A2<A4) – False
C. =AND(A2<A4, A2+A3=24) – False

II.	 A. =IF(A2<100, “Within budget”, “Over budget”)
	 B. =IF(A2=100, SUM(B5:B15), “ “)

III.	� Olive oil can be purchased according to this 
price schedule:

A B
1 Cost / gallon for the first 500 

gallons
$23

2 Cost / gallon for gallons above 500 $20
3 Number of gallons
4 10 230
5 483 11109
6 500 11500
7 1,600 33,500
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IV.	 Write IF statements to calculate the cost of 
the quantities of olive oil listed in cells A5, 
A6 and A7 above:
A. =IF(A5<=500, B1*A5, 500*B1+(A5-500)*B2)
B. =IF(A6<=500, B1*A6, 500*B1+(A6-500)*B2)
C. =IF(A7>500, B1*A7, 500*B1+(A7-500)*B2)

Chapter 3. �F orms In MS-Access

Page No. 31

I.	 Fill in the blanks:
1.	 Auto order
2.	 Arrange tab
3.	 Themes group design
4.	 Property sheet
5.	 Unbound

II.	 Answer the following:
1.	 �User Friendly Interface, Customizable 

Templates, Powerful Query Designer 
Integrated Reporting Tools, Customizable 
Forms, Macros for Automation.

2.	 �A form is a database object that we can use 
to enter, edit or display data from a table or 
a query.

3.	 �To create a form with a single mouse click 
with the Form Wizard or in Design View.

III.	 Answer in detail:  
1.	 Creating a form in MS-Access.

1.	� Select your database table by clicking on 
it in Access

2.	� Click the “Create” tab at the top, find the 
Forms Section and Select Form.

3.	� Microsoft Access will create a new form 
with all the columns of your table as 
fields.

4.	� You can now edit and also add new data 
to your table with this form.

5.	� Click the “Safe” icon at the top left cor-
ner to save your newly created form.

6.	� Enter a descriptive name for your form 
and click ok to save it.

Chapter 4. �D ata Types in C

Page No. 36-37

I.	 Answer the following:
1.	 �The data type in a programming language, 

is the collection of data with values having 
fixed meaning as well as characteristics. 
­Example: ­integer, float, character.

2.	 Write down the different data types in C.
	 Data types in C
		  1. Primary (Build-in) data types
		  2. Derived data types
		  3. User defined data types

3.	 Derived data types
		  Arrays, References, Pointers

4.	 Primary data type with variable names
		  int age;
		  char letter;
		  floag height, width;

II.	 Answer in detail:
1.	 i) Primary data types.

	 C compiler supports five primary data types
	 1. �void - It holds no value and is generally 

used for specifying the type of function 
or what is returns.

	 2. int - Used to denote an integer type 
	 3. char - Used to denote a character type
	 4. �float, double - Used to denote a ­floating 

point type
	 5. �int *, float *, char* - used to denote a 

pointer type
ii) Derived data types

	 C supports three derived data types
	 1. �Arrays – Arrays are sequences of data 

items having homogeneous values
	 2. �References – Function pointers 

allow referencing functions with a 
particular signature

	 3. �Pointers – Pointers are used to ­access 
the memory and deal with their 
addresses

iii) User defined data types
	 There are three such types
	 1. �Structure – It is a package of 

variables of different types under a 
single name
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	 2. �Union – These allow storing ­various 
data types in the same memory 
location

	 3. �Enum – Enum consists of integral 
constants, and each of them is as-
signed with a specific name.

2.	 # include <stdio.h>
int main()
{
	 int a = 1000; || positive integer data type
	 float b = 3.1743; || float data type
	 char c = ‘S’; || char data type
	 long d = 43657; || long positive integer
	� long e = -216556; || long negative 

data type
	 int f = -195; || negative integer data type
	 short g = 160; || short positive integer
	� double h = 4.1234567890 || double 

float data type
}

Chapter 5. � Robotics with LEGO 
MINDSTORMS EV3

Page No. 48

I Fill in the blanks:
1.	 Lego Mindstorm
2.	 EV3 software
3.	 Ultrasonic sensor
4.	 Color

II True of False:
1.	 True
2.	 True
3.	 False
4.	 True

III.	 Answer the following:
1.	 �Lego Mindstroms EV3 Core Kit is a robotic 

kit that lets you build and program starter 
robot models. It has a programmable power 
brick, plus servo motors and color, touch 
and infra-red sensors that help the robot 
move and communicate.

2.	 �Distinguishes between seven different 
colors and can also detect the absence 
of color. It also serves as a light sensor by 
detecting light intensities.

3.	 �Color sensor, touch sensor, ultra sonic sensor, 
gyro sensor, accelerometer temperature 
sensor, light sensor.

4.	 �Measures the robot’s rotational motion and 
changes in its orientation. We can measure 
angles, create balancing robots and other 
things.

IV.	 Answer in detail:
1.	 1. Lego mind storms EV3 kit
	 2. EV3 software
	 3. Technic parts

• �Build a robot using Lego Technic pieces 
and the EV3 brick computer.

• �Download a program to make the robot 
drive

• �Experiment making your own 
programs using the EV3 software

• �EV3 uses drag and drop programming, 
we can drag and drop the code blocks 
to program your robot.

2.	 Main Components of Lego Mind Storm
	 1. EV3 Brick
	� Serves as the Control Center and Power 

Station for your robot, just like the CPU 
of a computer.

	 2. Color Sensor
	� Distinguishes between seven different colors 

and can also detect the absence of color.
	 3. Ultrasonic Sensor
	� Generates sound waves and reads their 

echoes to detect and measure distance 
from objects.

	 4. Gyro Sensor
	� Measures the robot’s rational motion 

and changes in its orientation.
	 5. Medium Motor
	� Can be programmed to turn on or off, 

control its power level.
	 6. Large Motor
	� Is optimized to be the driving base on 

your robots. Move steering or move tank 
programming block in the EV3 software, 
the large motors will coordinate the 
action simultaneously.
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Chapter 6. � Sensors in EV3

Page No. 58

I.	 Fill in the blanks:
1.	 Analog
2.	 Red
3.	 Pressed Released Bumped
4.	 Loop code

II.	 State True or False:
1.	 True
2.	 False
3.	 True
4.	 True

III.	 Answer the following:
1.	 �The touch sensor is an analog sensor that 

can detect when the sensor’s red button 
has been pressed and when it is released.  
The sensor can be programmed to trigger 
any action using three conditions. Pressed, 
released or bumped.

2.	 �The ultrasonic sensor is a digital sensor that 
can measure the distance to an object in front 
of it.  It does this by sending out high-frequen-
cy sound waves and measuring how long it 
takes the sound to reflect back to the sensor.

3.	 1. �Open the EV3 software and create a new 
project.

2. �Drag and drop the following  blocks from the 
block palette to the programming canvas 
Stat block: This block is used to start the 
program
Move Tank block: Set the tank block 
to move the robot forward for a specific 
number of steps
Wait block: This block is used to pause 
the program execution for a specified 
duration
Gyro Sensor block: Set the Gyro sensor 
block to measure the rotation angle of the 
robot.
Move Steering block: Set the move 
steering block to turn the robot to a 
­specific angle.

3. connect the blocks as follows :
• �Connect the start block to the Move 

Tank block 
• �Connect the move tank block to the wait 

block 
• �Connect the wait block to the Gyro Sen-

sor block
• �Connect the Gyro Sensor block to the 

move steering block.
4. Configure the blocks as follows 

Move Tank block :
• �Select the motors you want to use for 

movement (e.g left motor and right 
motor)

• Set the power level (e.g 50% power)
• �Specify the number of steps you want 

the robot to move forward.
• �Wait block: Set the duration for 

which you want the program to pause 
(e.g 1 second)

Gyro sensor block
• �Select the gyro sensor connected to the 

EV3 robot.
• �Set the mode to “Angle” to measure the 

rotation angle of the robot.
Move steering block
• �Select the motors you want to use for 

turning (e.g left motor and right motor)
• �Set the power level (e.g 50% power)
• �Specify the angle you want the robot to 

turn 9e.g 90 degrees)

IV.	 Answer in detail:
1.	 1. Gyro Sensor

�Gyro sensor detects rotational motion of 
your robot.  The sensor measures the rate 
of rotation in degrees per second.

2. Touch Sensor
�The Touch sensor is an analog sensor that 
can detect when the sensor’s red button 
has been pressed and when it is released.  
The sensor can be programmed to trig-
ger any action using three conditions.  
Pressed, released or bumped.

3. Ultrasonic Sensor
�The Ultrasonic sensor is a digital sensor 
that can measure the distance to an object 
in front of it.  The Ultrasonic sensor can 
help your robots avoid furniture, track a 
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moving target detect an intruder in your 
room or “Ping” with increasing volume or 
frequency as an object gets closer to the 
sensor.

2.	 1. �Open the EV3 software and create new 
project

2. �Drag and drop the following blocks from 
the block palette to the programming 
canvas
Start block: This block is used to start 
the program
Loop block: This block is used to 
continuously check the touch sensor.
Touch Sensor block: Set the touch sen-
sor block to detect when the touch sensor 
is pressed.
Move steering block: Set the move 
steering block to turn the root.
Wait block: This block is used to pause 
the program execution for a specified 
duration.

3. Connect the block as follows 
• �Connect the start block to the Loop 

block 
• �Connect the Loop block to the Touch 

sensor block
• �Connect the Touch sensor block to the 

move steering block
• �Connect the move steering block to the 

wait block
• �Connect the wait block to the loop block

4. Configure the blocks as follows
Touch sensor block: Select the touch 
sensor connected to the EV3 robot.
Move steering block: Select the motors 
you want to use for turning (e.g left motor 
and right motor)
Set the power level (e.g 50% power)
Specify the angle you want the robot to 
turn(e.g 180 degrees)
Wait block 
Set the duration for which you want the 
program to pause (e.g 1 second)

Chapter 7. � Sensors in Micro Bit

Page No. 67-69

I.	 Fill in the blanks:
1.	 Touch capacity
2.	 Light
3.	 USA 1950
4.	 Temperature
5.	 Movement

II.	 State True or False:
1.	 True
2.	 True
3.	 False
4.	 True
5.	 True

III.	 Answer the following:
1.	 �A sensor is a device that detects and 

responds to some type of input from the 
physical environment.

2.	 �A temperature sensor is an input device 
that measures temperature. The BBC 
micro: bit has a temperature sensor inside 
the processor which can give you an 
approximation of the air temperature.

3.	 �The touch logo used capacitive touch, 
­sensing tiny changes in electrical fields to 
know when your finger is pressing it. Just 
like your phone or tablet screen.

4.	 �An accelerometer is a motion sensor that 
measures movement.  The accelerometer in 
the BBC micro: bit detects when you tilt it 
from left to right, backwards and forwards 
and up and down. You can program the 
micro: bit to use the accelerometer to create 
interesting applications.
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IV.	 Answer in detail:
1.	 a. Accelerometer

	� An accelerometer is a motion sensor that 
measures movement.

	 b. Temperature sensor
	� A temperature sensor is an input device 

that measures temperature. The BBC 
micro: bit has a temperature sensor 
inside the processor which can give you 
an approximation of the air temperature.

	 c. Light sensor
	� A light sensor is an input device that 

measures light levels.
	 d. Touch sensor
	� The touch logo uses capacitive touch, 

sensing tiny changes in electrical fields 
to know when your finger is pressing it.  
Just like your phone or tablet screen.

Chapter 8. � More on the Internet

Page No. 76-77

I.	 Choose the correct answer:
1.	 a) electronic mail
2.	 c) irctc.co.in
3.	 b) ATM
4.	 b) 2GB
5.	 c) Netiquette

II.	 Answer the following:
1.	 �Internet is a network of networks having 

number of computers connected to each oth-
er to share information, programs, data and 
other media elements among themselves.

2.	 �Video conferencing is a process in which 
two or more people have a real-time 
conversation face to face but being in 
different locations. It is one of the most 
popular type of communication in this 
modern era of computers and smart phones.

3.	 �E_learning enables online educational 
programs that help in obtaining degrees 
and certifications. An e_learning course 
could be as simple as making a lemon juice 
to building a rocket.

4.	 �Some of the most popular social networking 
sites:

	� Facebook.com, twitter.com, instagram.com, 
youtube.com, linkedin.com

5.	 �Team viewer is a proprietary computer 
software program for remote control, 
desktop sharing, online meetings, web 
­conferencing and file transfer between 
computers.

III.	 Answer in detail:
1.	 • �We can add photos and albums of our 

choice
• �We can search for our friends and ­relatives 
• �Songs and videos can be uploaded and 

shared
• �These websites help us chat with people 

of our choice
2.	 1. Communication:

	� One should be courteous and respectful 
to others while sending e_mail or 
chatting on the internet. Do not use 
offensive language or word.

	 2. Be tolerant and careful:
	� One should be tolerant and careful 

while listening to others and should not 
jump to any conclusions as different 
people from all over the world may have 
different views.

	 3. Keep personal information private: 
	� One should keep personal information 

private and should not share it over 
the internet, as it can have serious 
consequences.

	 4. Cyber Bullying:
	� Intention to hurt or embarrass another 

person by sending or posting wrong 
text or images through the internet, cell 
phones or other devices is defined as 
cyber bullying.

	 5. Language issues:
	� One should not use offensive language 

/comments and hurt other people’s 
feelings.

	 6. Copyright laws:
	� Copyright laws should always be obeyed 

while copying text or saving any picture.
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Chapter 9.  Computer Virus

Page No. 84

I.	 Choose the correct answer:
1.	 d) Vital information resource under siege
2.	 b) macro
3.	 c) wings.zmist
4.	 c) program
5.	 d) both a and c

II.	 Answer the following questions:
1.	 �A virus is a self-replicating program that 

can cause damage to data and files stored 
on your computer. Virus stands for Vital 
Information Resource Under Siege.

2.	 �From pen drives or other portable storage 
devices, From a computer network, From 
the internet, From E-mail

3.	 �Anti virus is a computer software that helps 
detect malicious software such as viruses 
and worms. They are installed in a computer 
to detect and eliminate know viruses.

4.	 • Cleans infected files and system
	 • Detects infected programs
	 • �Blocks the user from accessing an ­infected 

file
5.	 Anti-virus software

• Avast
• MCAfee
• Norton
• Sophs
• AVG
• Kaspersky
• Panda
• VFT
• F-secure

III.	 Answer in detail:
1.	 • Scan your system regularly

• Keep a backup
• Scan downloaded files
• �Scan removable disks such as CD’s, Pen 

drives, etc.
• �Turn e-mail preview option off and scan 

all e-mail attachments

• Update the anti-virus on a regular basis 
• �Do not download pirated software, 

movies, songs, games
• Do not visit unauthorized web sites
• Use an original operating system

2.	 • �Computer programs take longer to boot 
than normal

• The hard drive runs when not used
• �New files or folders keep appearing on 

the system
• Beeping noises come from the computer
• �Strange graphics are displayed on the 

computer monitor
• Program size keeps changing
• Programs act erratically

3.	 • Log on to microsoft security essentials
• �Page and download the software. Click on 

the download new button
• �After the downloading is completed 

double click the MSE Install icon to begin 
the installation process

• �The installation is generally self 
explanatory just follow the instructions 
that appear on screen. Click on the check 
box to turn on the windows firewall when 
asked to.

• �When it is done, it will ask you to run a 
scan. Click on Yes and it will download the 
latest virus definitions and run its first 
scan.

4.	 • �Microsoft security essentials will now run 
in the background constantly monitoring 
your computer for any viruses

• �The green icon means that the security 
status of your computer is good

• �Whenever your computer has an issue 
the appearance of the Microsoft security 
essentials home page changes

• �The status pane will turn either yellow or 
red depending upon the type of issue, the 
antivirus software has detected.

• �A yellow icon means that your ­computer 
is unprotected and that some action 
should be taken

• �A red icon means that your computer is at 
risk and that immediate action is required 
to protect it
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Class : 8   KEY ANSWERS

Chapter 1. � Number System

Page No. 9

I.	 Choose the correct answer
1.	 b) 8
2.	 a) Digital
3.	 c) 16
4.	 a) Most Significant Bit
5.	 b) Octal

II.	 Answer the following questions:
1.	 �A bit is a small piece of data that is derived 

from the words “Binary digit.
2.	 �A number system denotes a group of 

characters which denote various numerical 
quantities.

3.	 �Binary, Octal, Decimal, Hexadecimal
4.	 �Sound waves, Telephone signals, 

Temperatures
5.	 �MSB - The left most bit in the binary number 

is called Most Significant Bit.
	� LSB - The right most bit in the binary 

­number is called Least Significant Bit

III.	 Solve the following:

1. 1 1 1
1 0 1 1 0 0 1

1 1 0 0 1 1
(+) 1 0 0 0 1 1 0 0

(1011001)2 + (110011)2 = (1 0 0 0 1 1 0 0)2

2. 0 10
1 1 0 1
1 0 1 0

(+) 0 0 1 1

(1101)2 – (1010)2 = (0011)2

3.	 (i) (F4)16 = (1 1 1 1   0 1 0 0)2

(ii) (CAB)16 = ( 1 1 0 0    1 0 1 0    1 0 1 1)2

4.	 (i) (32)10

2 32
2 16 0
2 8 0
2 4 0
2 2 0

1 0

(32)10 = (100000)2

(ii) (65)10

2 65
2 32 1
2 16 0
2 8 0
2 4 0
2 2 0

1    0

(65)10 = (1000001)2

5.	 (i) ( 0  0  0 1 1  0  1  0 )2 = (1 A)16

	 1	 A

(ii) (0111)2 = (7)16 

IV.	 Answer the following:
1.	 • Binary number system

• Octal number system
• Decimal number system
• Hexa decimal number system

Binary number system: In the binary number 
system, only the digits, 0s and 1s, are used. 
Ex.: (11011)2
Octal number system: The octal number system, 
which has the base 8, contains eight symbols(0-7). 
Ex.: (426)8
Decimal number system: The system that uses 
the decimal numbers or digits 0 to 9 is called the 
decimal number system. This system is said to have 
a base, or radix, of ten. Ex.: (597)10
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Hexa decimal number system: The sixteen 
symbols that are used in the hexadecimal system 
are 0, 1, 2, .. 9, A, B, C, D, E and F. Ex.: (2A7)16

2.	 Convert the following :		
1. (i) 2 516

2 258 0
2 129 0
2 64 1
2 32 0
2 16 0
2 8 0
2 4 0
2 2 0

1 0

(516)10 = (1004)8

(ii) 8 516
8   64 4
8    8 0

   1 0

(516)10 = (204)16

(iii) 16 516
16 32 4
16   2 0

(516)10 = (1000000100)2

Chapter – 2:  Functions in “C”

Page No. 22

I.	 Match the following:

stdio.h - This is a standard input/output 
header file. It contains all the li-
brary functions Regarding standard 
input/output.  

conio.h - This is a console input/output 
header file

stdlib.h - This header file contains all the 
general library functions like mal-

loc(), calloc(); exit(), etc…

string.h - It contains all string related library 
functions like get(), puts(), etc…

math.h - This header file contains all the 
math operations related functions 

like sqrt(), pow(), etc…..

II.	 Answer the following:
1.	 �A function is a set of code that take inputs, do 

some specific computation and produces ­output.
2.	 • �Functions help us in reducing code 

redundancy, which means repeating a set of 
code repeatedly.

• Functions make code modular
• Functions provide abstraction

3.	 �By using function prototype we declare a 
function in “C”

Function Prototype
Header	 •	� return data type function name 

(parameter)
Body	 •	 statements return 0;

III.	 Answer in detail:
1.	 1. Refer Q1, Advantages of Functions in C, Q3

2. Refer the book page no.20 and 21

IV.	 Lab time:

2.	
#include <stdio.h>

int main() {
	 int number;

	 printf(“Enter a number: “);
	 scanf(“%d”, &number);

	 if (number % 2 == 0) {
	 printf(“%d is an even number.\n”, number);
	 } else {
	 printf(“%d is an odd number.\n”, number);
	 }

	 return 0;
}
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Chapter – 3: � Variables and Constants 
in “C”

Page – 29.

I.	 Choose the right answer:
1.	 b) int count;
2.	 a) True
3.	 a) Const
4.	 b) Static

II.	 Answer the following:
1.	 �In “C”, a variable has a name and contains a 

value.
2.	 �Constants are values that are fixed throughout 

the program.
3.	 1. Local

2. Global
3. Static
4. External
5. Automatic

4.	 �External variable can be shared across 
­multiple “C” program files, this variable is 
declared using the extern keyword.

III.	 Answer in detail:
1.	 Refer Book Page No. 25, 26
2.	
	 # include <stdio.h>
	 {
		  float a, b, avg;
		  printf (“ Enter first number “);
		  scanf (“%f”, &a);
		  printf(“ Enter second number “);
		  scanf (“%f”, &b);
		  avg=(a+b)/2;
		  printf(“ Average of two numbers = %f”, avg);
		  return 0;
	 }
3.	
	 # include <stdio.h>
	 int main()
	 {
		  int a, b, c;
		  printf(“ Enter first number”);

		  scanf (“%d”, &a);
		  printf (“Enter second number”);
		  scanf (“%d”, &b);
		  c = a-b;
		  printf(“Difference of two numbers is = %d”, c);
		  return 0;	
	 }

IV.  Project Time:
1.	
	 #include <stdio.h>

	 int main() {
		  int num1, num2;

		  printf(“Enter the first number: “);
		  scanf(“%d”, &num1);

		  printf(“Enter the second number: “);
		  scanf(“%d”, &num2);

		�  // Adding and subtracting 20 and 30 from 
the numbers

		  int added_num1 = num1 + 20;
		  int added_num2 = num2 + 20;
		  int subtracted_num1 = num1 - 30;
		  int subtracted_num2 = num2 - 30;

		�  printf(“After adding 20, the first number 
­becomes: %d\n”, added_num1);

		�  printf(“After adding 20, the second number 
becomes: %d\n”, added_num2);

		�  printf(“After subtracting 30, the first ­number 
becomes: %d\n”, subtracted_num1);

		�  printf(“After subtracting 30, the second 
­number becomes: %d\n”, subtracted_num2);

		  return 0;
	 }
	 #include <stdio.h>

	 int main() {
		  int num1, num2;

		  printf(“Enter the first number: “);
		  scanf(“%d”, &num1);

		  printf(“Enter the second number: “);
		  scanf(“%d”, &num2);
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		  int sum = num1 + num2;
		  int difference = num1 - num2;
		  int product = num1 * num2;
		  int quotient = num1 / num2;
		  int remainder = num1 % num2;

		  printf(“Sum: %d\n”, sum);
		  printf(“Difference: %d\n”, difference);
		  printf(“Product: %d\n”, product);
		  printf(“Quotient: %d\n”, quotient);
		  printf(“Remainder: %d\n”, remainder);

		  return 0;
	 }

Chapter – 4: � CONTROL STATEMENTS 
AND LOOPS IN C

Page No. 40-42

I 	 Fill in the blanks:
1.	 Conditional or decision-making
2.	 Root directory
3.	 default
4.	 break
5.	 loop
6.	 Rename

II.	 True / False
1.	 True
2.	 True
3.	 True

III.	 Choose:
1.	 c) executes continuously
2.	 b) for loop
3.	 b) do while

IV.	 Project Time:
1.	

	 #include <stdio.h>

	 int main() {
		  int number;

		  printf(“Enter a number: “);
		  scanf(“%d”, &number);
		  if (number % 3 == 0) {
		  printf(“%d is a multiple of 3.\n”, number);
		  } else {
		  printf(“%d is not a multiple of 3.\n”, number);
	 }

	 return 0;
	 }

2.	
	 #include <stdio.h>

	 int main() {
	 int a,b,c;

	 printf(“Enter three numbers: “);
	 scanf(“%d %d %d”, &a, &b, &c);

	 if (a >= b && a >= c {
		  printf(“%d is the greatest number.\n”, a);
	 } else if (b >= a && b >= c) {
		  printf(“%d is the greatest number.\n”,b);
	 } else {
		  printf(“%d is the greatest number.\n”, c);
	 }
	 return 0;

3.	
	 Fibonacci Series.
	 # include <stdio.h>
	 int main()
	 {
		  int i, n;
		  int f1=0, f2=1;
		  int f3=f1+f2;
		  printf (“ Enter the number of terms “);
		  scanf(“%d”, &n);

		  printf(“ Fibonacci Series %d %d “, f1, f2)
		  for (i=3; i<=n, ++i)
		  {
			   printf(“%d”, f3);
			   f1=f2;
			   f2=f3;
			   f3=f1+f2;
		  }
		  return 0;	
	 }
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4.	
	 //for loop

	 #include <stdio.h>

	 int main() {
		  int i;

		  printf(“Using for loop:\n”);
		  for (i = 0; i < 10; i++) {
			   printf(“Computer\n”);
		  }

		  return 0;
	 }

	 //while loop
	 #include <stdio.h>

	 int main() {
		  int i = 0;

		  printf(“Using while loop:\n”);
		  while (i < 10) {
			   printf(“Computer \n”);
			   i++;
		  }

		  return 0;
	 }

	 //do while loop

	 #include <stdio.h>

	 int main() {
		  int i = 0;

		  printf(“Using do-while loop:\n”);
		  do {
			   printf(“Computer \n”);
			   i++;
		  } while (i < 10);

		  return 0;
	 }

Chapter – 5:  Arrays in “C”

Page No. 48-49

I.	 Fill in the blanks:
1.	 Array
2.	 index position

II.	 True or False
1.	 True
2.	 False

III.	 Choose the correct answer:
1.	 b) 0

IV.	 Project Time:
1.	
	 #include <stdio.h>

	 // Function to search for a value in an array
int searchArray(int *arr, int size, int value) {
	 int i;

	 for (i = 0; i < size; i++) {
		  if (arr[i] == value) {
			   return i; // Return the index if value 
is found
		  }
	 }

	 return -1; // Return -1 if value is not found
}

int main() {
	 int arr[] = {1, 2, 3, 4, 5, 6, 7, 8, 9, 10};
	 int size = sizeof(arr) / sizeof(arr[0]);
	 int searchValue;
	 int result;

	 printf(“Enter the value to search: “);
	 scanf(“%d”, &searchValue);

	 // Call the searchArray function to find the val-
ue in the array
	 result = searchArray(arr, size, searchValue);

	 if (result != -1) {
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		�  printf(“Value %d found at index %d.\n”, 
searchValue, result);

	 } else {
		�  printf(“Value %d not found in the array.\n”, 

searchValue);
	 }

	 return 0;
	 }

2.	
	 #include <stdio.h>
	 void bubbleSort(int arr[], int size) {
		  int i, j, temp;

		  for (i = 0; i < size - 1; i++) {
			   for (j = 0; j < size - i - 1; j++) {
			   if (arr[j] > arr[j + 1]) {
				    temp = arr[j];
				    arr[j] = arr[j + 1];
				    arr[j + 1] = temp;
				    }
			   }
		  }
	 }

	 int main() {
		  int arr[] = {5, 2, 8, 1, 6};
		  int size = sizeof(arr) / sizeof(arr[0]);
		  int i;

		  printf(“Original array: “);
		  for (i = 0; i < size; i++) {
			   printf(“%d “, arr[i]);
		  }

		  bubbleSort(arr, size);

		  printf(“\nSorted array in ascending order: “);
		  for (i = 0; i < size; i++) {
			   printf(“%d “, arr[i]);
		  }

		  return 0;
	 }

3.	
	 #include <stdio.h>

	 int main() {
		�  int numGrades, i, numStudents, total 

Strength = 0;

		�  printf(“Enter the number of grades or classes: “);
		  scanf(“%d”, &numGrades);

		  for (i = 1; i <= numGrades; i++) {
			�   printf(“Enter the number of students in 

grade or class %d: “, i);
			   scanf(“%d”, &numStudents);
			   totalStrength += numStudents;
		  }

		�  printf(“Total strength of the school: %d\n”, 
totalStrength);

		  return 0;
	 }

Chapter – 6: � An introduction to 
HTML and formatting 
tags existing

Page No. 65-67

I.	 Choose the correct answer:
1.	 b) Hyper Text Markup Language
2.	 d) HTML
3.	 d) both a and b
4.	 a) Tim Berners Lee
5.	 b) <>
6.	 b) 6
7.	 a) left
8.	 a) <br>
9.	 c) <br>
10.	c) No shade

II.	 Answer the following:
1.	 �HTML stands for Hyper Text Markup 

Language. Hypertext is simply a piece of text 
that contains links to other texts. Markup 
language is a way of writing style and layout 
information within a text document.
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2.	 • HTML Editor
• Web Browser
• Web Server

3.	 �HTML editor is a software application required 
to create web pages. Some editors are:
• WYSIWYG Editor
• Text Editor

4.	 �WYSIWYG stands for What You See Is What 
You Get.

5.	 • Internet Explorer
• Mosaic
• Netscape Navigator
• Net Cruiser
• Mac web/Win Web
• Mozilla Firefox
• Opera

6.	 �A tag is an element that instructs the web 
browser what to display and how to display it.

7.	 �A web server is a software that uses HTTP 
(Hyper Text Transfer Protocol) to serve the 
files that form web pages to users.

8.	 �A tag that has both a start tag and an end tag 
is called a container tag.
Ex. <HTML>…..</HTML>
      <BODY>……</BODY>

9.	 �Tags what have only a start tag and do not 
contain text or any other tag elements are 
called empty tags.
<BR>, <HR>…..

10.	• Head Section
• Body Section

11.	�Heading tags used to provide a heading to a 
web page.

12.	<HTML>
<HEAD>
<TITLE> Paragraph alignment </TITLE>
</HEAD>
<BODY>
<Palign = “left”> unity is strength </p>
<Palign = “center”> unity is strength </P>
<Palign = “right”> unity is strength </P>
</BODY> 
</HTML>

13.	�Center tag displays the text or an image in 
the center of the web page.

14.	�Size attribute is used to increase or decrease 
the font size.

15.	�Superscript tag is used to display the text in 
the superscript format.
Subscript tag is used to display the text in 
the subscript format.

III.	 Answer in detail:
1.	 An HTML document has two sections, 

• Head Section
• Body Section

Head Section: The head section contains 
information about the document.
Body Section: The body section defines the 
document’s body. This section may contain 
several other tags.

Head Section:
<HTML>
<HEAD>
<TITLE>…….</TITLE>
</HEAD>

Body Section:
<BODY>
</BODY>
</HTML>

<TITLE> - This is used to provide the title to 
as HTML document
</TITLE> - This tag is used to end a title.
<HEAD> - This tag is used to provide a head-
ing to a web page
</HEAD> - This tag is used to end the heading
<BODY> - This tag hold the body of the page
</BODY> This tag is used to end the body

2.	 �To create, save, and view an HTML document, 
you can follow these steps:
1.	 �Create an HTML file: Open a text editor (e.g., 

Notepad) and create a new file. Save it with a 
.html extension, such as example.html.

2.	 �Write HTML code: Inside the HTML file, 
write your desired HTML code. For example, 
you can create a simple HTML structure 
with a heading and a paragraph:

3.	 �Save the HTML file: Save the file after 
writing the HTML code.
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4.	 �View the HTML document: Open the 
saved HTML file in a web browser (e.g., 
Google Chrome, Mozilla Firefox). You can 
­either double-click the file or right-click and 
choose “Open with” to select a browser.

3.	 an HTML code to display your address.
<HTML>
<HEAD>
<TITLE> my address </TITLE>
</HEAD>
<BODY>
XXXX
Siddhu Matric. Hr. Sec. School
5, Vijayalakshmi Theatre Road,
Viswanathapuram,
Madurai-14
</BODY>
</HTML>

4.	 �To reduce the size of the text from the 
normal size, we use <Small> tag. To display 
a text bigger than the normal size, we use 
<Big> tag.

5.	 1. �<b> and <strong>: These tags are used 
to make text bold. They are typically 
used to emphasize important or strong 
content.

2. �<i> and <em>: These tags are used to 
italicize text. They are commonly used 
to indicate emphasis or to differentiate a 
particular section of text.

3. �<u>: This tag is used to underline text. 
It is often used to highlight or indicate 
links or important information.

4. �<s> and <strike>: These tags are used to 
strikethrough text. They are often used 
to indicate deleted or outdated content.

5. �<sub>: This tag is used to render 
subscript text. It is commonly used for 
mathematical or chemical formulas 
where smaller text is placed below the 
baseline.

6. �<sup>: This tag is used to render 
superscript text. It is commonly used for 
mathematical equations or to indicate 
footnotes.

Chapter – 7:	H TML – Level  II

Page No. 75

I.	 Choose the correct answer:
1.	 d) all of these
2.	 b) double quotes
3.	 c) 3
4.	 c) BG Sound
5.	 a) 3

II.	 Answer the following:
1.	 �We can change the font of the text in HTML 

using the face attribute of <Font> tag.

2.	 List out different lists in HTML.
• Ordered List
• Unordered List
• Definition List

3.	 �Moving or scrolling text can be placed in a 
web page by using <marquee> tag.

4.	 �To change the background color of a web page, 
by color attribute is used in the body tag.

5.	 �The <BGSOUND> tag is used to add sound 
for HTML.

III.	 Answer in detail:
1.	 Refer book page no.71
2.	 Refer book page no.73
3.	 Refer book page no.73
4.	 Refer book page no.74

Chapter 8. MORE  ON EV3

Page No. 80

I.	 Fill in the blanks:
1.	 Color
2.	 7
3.	 loop
4.	 Orange
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II.	 Answer the following:
1.	 �The color sensor is used to make the EV3 

­follow a line, find a color, move until ­reaching 
a line and other such operations.

2.	 To repeat a set of blocks is called a loop.
3.	 black, brown, blue, green, yellow, red, white

III.	 Answer in detail:
1.	 Refer the Book Page No. 76
2.	 Refer the Book Page No. 79 & 80

IV.	 Project time:
	 # Line Follower Program with Touch Sensor Stop

	 # Import the necessary modules
	� from ev3dev2.motor import OUTPUT_A, 

OUTPUT_B, MoveTank
	� from ev3dev2.sensor import INPUT_1, IN-

PUT_2, INPUT_3
	� from ev3dev2.sensor.lego import ColorSensor, 

TouchSensor

	 # Initialize the sensors and motors
	 tank = MoveTank(OUTPUT_A, OUTPUT_B)
	 color_sensor = ColorSensor(INPUT_1)
	 touch_sensor = TouchSensor(INPUT_3)

	� # Set the desired speed and adjust the following 
values as needed

	 speed = 20
	 threshold = 30

	 # Main program loop
	 while not touch_sensor.is_pressed:
		�  # Read the reflected light intensity from the 

color sensor
		�  intensity = color_sensor.reflected_light_­

intensity

		�  # Adjust the motor speeds based on the 
­intensity of the reflected light

		�  if intensity < threshold: # Line is to the right, 
turn left

			�   tank.on(left_speed=speed, right_speed=0)
		  else:  # Line is to the left, turn right
			�   tank.on(left_speed=0, right_speed=speed)

	 # Stop the robot when the touch sensor is pressed
	 tank.off()

Chapters 9. I oT ON MICRO:BIT

Page No. 84

I.	 Fill in the blanks
1.	 25
2.	 BBC
3.	 magnetometer
4.	 loop
5.	 255

II. Answer the following
1.	 �sensor is a hardware component that 

detects and measures physical quantities or 
environmental conditions.

2.	 Accelerometer
Magnetometer
Temperature Sensor
Light Sensor

3.	 Refer the book pg no 81
4.	 Refer the book pg no 81
5.	 �Measures the sound levels in numbers 

between 0 and 255.

III.	 Answer in detail
1.	

	 from microbit import *

	 while True:
		  sound_value = microphone.sound_level()

		  if sound_value > 200:
			   display.show(Image.ASLEEP)
			   music.play(music.BA_DING)
			   display.clear()
		  else:
			   display.show(Image.HAPPY)

2.	 Refer the book page no. 83.
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